DSP Mix Engine Card
for VENUE Systems
Legal Notices

This guide is copyrighted ©2012 by Avid Technology, Inc., (hereafter “Avid”), with all rights reserved. Under copyright laws, this guide may not be duplicated in whole or in part without the written consent of Avid.


Product features, specifications, system requirements, and availability are subject to change without notice.

Guide Part Number 9320-62787-00 REV B 11/12

Documentation Feedback

We are always looking for ways to improve our documentation. If you have comments, corrections, or suggestions regarding our documentation, email us at techpubs@avid.com.

Safety Compliance

Safety Statement

This equipment has been tested to comply with USA and Canadian safety certification in accordance with the specifications of UL Standards: UL60065 7th /IEC 60605 7th and Canadian CAN/CSA C22.2 60065:03. Avid Inc., has been authorized to apply the appropriate UL & CUL mark on its compliant equipment.

Warning

Important Safety Instructions

1) Read these instructions.
2) Keep these instructions.
3) Heed all warnings.
4) Follow all instructions.
5) Only perform the services explicitly described in the install and or user manual. For services or procedures not outlined in the install or user manual, speak with authorized service personnel.
6) Do not use this equipment near water.
7) Clean only with dry cloth.
8) Do not block any ventilation openings. Install in accordance with the manufacturer's instructions.
9) Do not install near any heat sources such as radiators, heat registers, stoves, or other equipment (including amplifiers) that produce heat.
10) Do not defeat the safety purpose of the polarized or grounding-type plug. A polarized plug has two blades with one wider than the other. A grounding type plug has two blades and a third grounding prong. The wide blade or the third prong are provided for your safety. If the provided plug does not fit into your outlet, consult an electrician for replacement of the obsolete outlet.
11) Protect power cords from being walked on or pinched particularly at plugs, convenience receptacles, and the point where they exit from the equipment.
12) Only use attachments/accessories specified by the manufacturer.
13) For products that are not rack-mountable: Use only with a cart, stand, tripod, bracket, or table specified by the manufacturer, or sold with the equipment. When a cart is used, use caution when moving the cart/equipment combination to avoid injury from tip-over.
14) Unplug this equipment during lightning storms or when unused for long periods of time.
15) Refer all servicing to qualified service personnel. Servicing is required when the equipment has been damaged in any way, such as power-supply cord or plug is damaged, liquid has been spilled or objects have fallen into the equipment, the equipment has been exposed to rain or moisture, does not operate normally, or has been dropped.
16) For products that are a Mains powered device: The equipment shall not be exposed to dripping or splashing and no objects filled with liquids (such as vases) shall be placed on the equipment.

Warning! To reduce the risk of fire or electric shock, do not expose this equipment to rain or moisture.

17) For products containing a lithium battery: CAUTION! Danger of explosion if battery is incorrectly replaced. Replace only with the same or equivalent type.
18) The power inlet is the main disconnect device and should remain accessible. Disconnect the power cord before servicing the unit.
19) The equipment shall be used at a maximum ambient temperature of 40° C.
20) Disconnect power from mains before opening the product (console and Stage 48)
Contents

Chapter 1. Overview .......................................................... 1
  Mix Engine Card Components ........................................... 1
  System Requirements and Compatibility ............................... 1
  Registration ..................................................................... 1
  Conventions Used in This Guide ....................................... 2
  About www.avid.com ...................................................... 2

Chapter 2. Installing a Mix Engine Card .................................. 3
  FOH Rack Mix Engine Card Installation ............................... 3
  Mix Rack Mix Engine Card Installation ................................ 5

Appendix A. Compliance Information .................................... 11
  Environmental Compliance ............................................. 11
  EMC (Electromagnetic Compliance) ................................. 11
The DSP Mix Engine card adds mixer and plug-in processing capacity to the VENUE FOH Rack and Mix Rack.

A total of five Mix Engine cards can be installed in the FOH Rack. In its base configuration, the FOH Rack contains three Mix Engine cards.

A total of three Mix Engine cards can be installed in the Mix Rack. In its base configuration, the Mix Rack contains two Mix Engine cards.

Mix Engine Card Components

The Mix Engine card package includes the following items:

- Mix Engine card
- TDM FlexCable
- Mounting screws
- Registration Information Card

System Requirements and Compatibility

The DSP Mix Engine Card requires either of the following:

- A VENUE FOH Rack
  - or -
- A VENUE Mix Rack

Avid can only assure compatibility and provide support for hardware and software it has tested and approved. For complete system requirements and a list of qualified computers, operating systems, hard drives, and third-party devices, visit: www.avid.com/compatibility

Registration

Review the enclosed Registration Information Card and follow the instructions on it to quickly register your purchase online. By registering, you become eligible to receive the following:

- Technical support information
- Software update and upgrade notices
- Hardware warranty information
## Conventions Used in This Guide

All of our guides use the following conventions to indicate menu choices and key commands:

<table>
<thead>
<tr>
<th>Convention</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>File &gt; Save</td>
<td>Choose Save from the File menu</td>
</tr>
<tr>
<td>Control+N</td>
<td>Hold down the Control key and press the N key</td>
</tr>
<tr>
<td>Control-click</td>
<td>Hold down the Control key and click the mouse button</td>
</tr>
<tr>
<td>Right-click</td>
<td>Click with the right mouse button</td>
</tr>
</tbody>
</table>

The names of Commands, Options, and Settings that appear on-screen are in a different font.

The following symbols are used to highlight important information:

- **User Tips** are helpful hints for getting the most from your system.

- **Important Notices** include information that could affect your data or the performance of your system.

- **Shortcuts** show you useful keyboard or mouse shortcuts.

- **Cross References** point to related sections in this guide and other VENUE guides.

## About www.avid.com

The Avid website (www.avid.com) is your best online source for information to help you get the most out of your system. The following are just a few of the services and features available.

**Product Registration** Register your purchase online.

**Support and Downloads** Contact Customer Success (technical support); download software updates and the latest online manuals; browse the Compatibility documents for system requirements or search the online Knowledgebase.

**Training and Education** Study on your own using courses available online or find out how you can learn in a classroom setting at a certified Avid training center.

**Products and Developers** Learn about Avid products; download demo software or learn about our Development Partners and their plug-ins, applications, and hardware.

**News and Events** Get the latest news from Avid or sign up for a product demo.

**Pro Tools Accelerated Videos** Watch the series of free tutorial videos. Accelerated Videos are designed to help you get up and running with Pro Tools and its plug-ins quickly.

**Live Sound Webinars** Watch free tutorial videos and VENUE-specific webinars to learn from the experts.

To learn more about these and other resources available from Avid, visit our website (www.avid.com).
Chapter 2: Installing a Mix Engine Card

This chapter provides instructions for installing a DSP Mix Engine Card in a VENUE FOH Rack or Mix Rack.

- For FOH Rack, see “FOH Rack Mix Engine Card Installation” on page 3.
- For Mix Rack, see “Mix Rack Mix Engine Card Installation” on page 5.

FOH Rack Mix Engine Card Installation

Additional Mix Engine cards are installed in the FOH Rack and are connected to each other by TDM FlexCables.

Each Mix Engine card has two ports along the top of the card, labeled Port A and Port B. The FlexCable has two connectors, also labeled Port A and Port B, to ensure proper connection. Using a FlexCable, data communication across multiple cards is achieved by connecting Port B of the first card to Port A of the next card, from Port B of that card to Port A of the next card, and so forth.

To install the Mix Engine card in the FOH Rack:

1. Shut down the system.
2. Disconnect all audio cables attached to the FOH Rack.

⚠️ Before handling any card, discharge static electricity from your clothes or body by touching a grounded metal surface such as the FOH Rack’s rack rails.

3. Remove the FOH Rack front panel faceplate by unscrewing its mounting screws (#1 Phillips).
4. Remove the Mix Engine card from its packing material. Hold the card by its edges.

Mounting bracket

TDM FlexCable connectors

Figure 2. Mix Engine card showing bracket and connectors

5. Remove the retaining bracket that secures the right side of the cards by loosening the thumbscrews and lifting the bracket.
6. Locate the open PCI slot closest to the currently installed Mix Engine cards.
7. Align the card with the corresponding cutout in the chassis and press down on the left side of the card so that it makes contact with the PCI slot.

Figure 3. Placing the Mix Engine card in a PCI slot (retaining bracket not shown)
8 Press down on the right side of the card to snap it in place in the FOH Rack chassis.

9 Attach the card to the chassis with one of the provided mounting screws.

10 Reattach the retaining bracket by sliding the tab under the holder and tightening the thumbscrews.

11 Proceed to connecting the TDM FlexCable.

To connect the Mix Engine cards with the TDM FlexCable:

1 Shape the FlexCable by grasping the cable with both hands and moving the Port A portion of the cable straight towards you and inwards, as shown below. Do not bend the cable more than you need to, as you may damage the traces in the cable.

2 Slide the FlexCable into the notch of the front card, so that the Port B connector of the FlexCable can be aligned with Port B of the back card; and the Port A connector of the FlexCable can be aligned with Port A of the front card.

3 Connect the Port A connector of the FlexCable to Port A on the front card. Push down gently but firmly until the cable is fully connected to the card.

4 Attach the other end of the FlexCable (labeled Port B) to Port B on the back card.

5 Verify the connection as shown below.

Figure 4. Snapping the Mix Engine card into place (retaining bracket not shown)

To complete and confirm installation:

1 Reattach the FOH Rack faceplate.

2 Reconnect the power, FOH Link, and any audio and MIDI cables to the FOH Rack.

3 Turn on the VENUE system.

4 Go to the Options page and click the Devices tab to view system hardware status. The newly installed Mix Engine card should be displayed in the FOH Rack graphic.

Figure 5. Preparing TDM FlexCable for installation

Figure 6. Inserting the TDM FlexCable

Figure 7. Top view of Mix Engine cards connected with TDM FlexCable

Option > Devices page showing 3 Mix Engine cards in FOH Rack
Mix Rack Mix Engine Card Installation

Installing an additional Mix Engine card in Mix Rack consists of the following steps:

- Preparing for installation by opening Mix Rack and disconnecting existing ribbon cables
- Installing the new Mix Engine card
- Connecting the included TDM FlexCable, and reconnecting existing ribbon cables
- Completing and confirming installation

Preparing the Mix Rack

To prepare a Mix Rack for Mix Engine card installation:

1. Shut down the system.
2. Disconnect all audio cables attached to the Mix Rack.

⚠️ Before handling any card, discharge static electricity from your clothes or body by touching a grounded metal surface, such as the Mix Rack’s rack rails.

3. Remove the Mix Rack front panel faceplate by unscrewing its mounting screws (#1 Phillips).

4. Via the open front panel, carefully disconnect the 50-pin ribbon cables from each Stage I/O card (AI16, AO16, XO16, and/or AT16 cards) or the Ethernet Snake card. Release the ribbon cable connectors from the ports on the cards by pushing the two plastic latches securing each connector outwards.

💡 Mark each cable as appropriate to facilitate reconnect ion. You can use a marker to write directly on the ribbon cable.

5. Locate the two Mix Engine cards and the Hub 48 card currently installed in Mix Rack. Depending on your version of Mix Rack, Mix Engine cards may be installed adjacent to the Hub 48 card, or there may be one or more empty slots between the second Mix Engine card and the Hub 48 card.

危险 Disconnect the ribbon cables from the Stage I/O cards or the Ethernet Snake card only. Do not disconnect the black I/O card ribbon cable connectors from the Hub 48 card. Doing so could damage the Hub 48 card.

Figure 8. Front of the Mix Rack

Figure 9. Removing the Input and Output Card ribbon cable connectors

Figure 10. Mix Engine cards installed adjacent to the Hub 48 card (top-down view)

Figure 11. Example of a configuration with an empty slot between a Mix Engine card and the Hub 48 card (top-down view)
6 Do one of the following depending on your configuration:
   • If your Mix Rack has a ribbon cable with three connectors (the Clock Source Jumper cable) connecting the ports labeled “Snake” on the first and second Mix Engine cards to the port labelled “P1 Mix Engine” on the Hub 48 card (see Figure 12), disconnect this cable from both Mix Engine cards. Do not disconnect this cable from the Hub 48 card.
   – or –
   • If your Mix Rack has a standard dual-connector ribbon cable connecting the port labeled “Snake” on the first (innermost) Mix Engine card to the port labeled “P1 Mix Engine” on the Hub 48 card (see Figure 13), disconnect this cable from the Mix Engine card. Do not disconnect the cable from the Hub 48 card.

7 Disconnect the ribbon cable from the port labeled “FOHA” on the first (innermost) Mix Engine card. This cable connects the main IO card to the first Mix Engine card.

8 If any ribbon cables are attached to the ports labelled “FireWire” (located to the right of the “FOHA” ports) on either or both Mix Engine cards, disconnect them, noting their location. These cables are connected to any installed VENUE record/playback option cards and/or the Ethernet Snake card. In most cases there is only one cable present, and it is attached to the first (innermost) Mix Engine card.
Installing the New Mix Engine Card

To install the new Mix Engine card:

1. Remove the retaining bracket by loosening the thumbscrews and lifting the bracket. Set the bracket aside.

2. Remove the new Mix Engine card from its packing material. Hold the card by its edges.

3. Locate the open PCI slot closest to the currently installed Mix Engine cards. Depending on your version of Mix Rack, this slot is either directly behind the two Mix Engine cards, or between the second Mix Engine card and the Hub 48 card.

4. Align the card with the corresponding cutout in the chassis and press down on the left side of the card so that it makes contact with the PCI slot.

5. Press down on the right side of the card to snap it in place in the Mix Rack chassis.

6. Attach the card to the chassis with one of the provided mounting screws.

7. Reattach the retaining bracket by sliding the tab under the holder and tightening the thumbscrews.

Figure 16. Detail of retaining bracket

Figure 17. Mix Engine card showing bracket and connectors

Figure 18. Placing the Mix Engine card in a PCI slot
Installing the TDM FlexCable

The new card is connected to the adjacent Mix Engine card using the included TDM FlexCable. Each Mix Engine card has two ports along the top of the card, labeled Port A and Port B. The FlexCable has two connectors, also labeled Port A and Port B, to ensure proper connection. Using FlexCables, data communication across multiple cards is achieved by connecting Port B of the first card to Port A of the next card, from Port B of that card to Port A of the next card, and so forth.

To connect the TDM FlexCable and reconnect ribbon cables:

1. Prepare the TDM FlexCable for installation by grasping the cable with both hands and moving the Port A portion of the cable straight towards you and inwards, as shown below. Do not bend the cable more than you need to, as you may damage the traces in the cable.

![Figure 19. Preparing TDM FlexCable for installation](image)

2. Do one of the following, depending on the slot in which you installed the new Mix Engine card:
   - If you installed the new card **behind** the innermost card, slide the FlexCable into the notch of the Mix Engine card in front of the new card, so that the Port B connector of the FlexCable can be aligned with Port B of the new card; and the Port A connector of the FlexCable can be aligned with Port A of the adjacent card.
   - or –
   - If you installed the new card **between** the second Mix Engine card and the Hub 48 card, slide the FlexCable into the notch of the new Mix Engine card, so that the Port A connector of the FlexCable can be aligned with Port A of the new card; and the Port B connector of the FlexCable can be aligned with Port B of the adjacent card.

![Figure 20. Sliding the TDM FlexCable into the notch of the Mix Engine card](image)

3. Connect the Port A connector of the FlexCable to Port A on the card. Push down gently but firmly until the cable is fully connected to the card.

4. Connect the other end of the Port B connector of the FlexCable to Port B on the other card.

5. Verify the connection as shown below.

![Figure 21. Top view of Mix Engine cards connected with TDM FlexCable](image)

6. Reconnect ribbon cables for any VENUE record/playback option cards installed as follows:
   - If only one VENUE record/playback card (HDx, FWx, or MADI) is installed, connect its ribbon cable to the “FireWire” port on the first (innermost) Mix Engine card.
   - If a second VENUE record/playback card is installed, connect its ribbon cable to the “FireWire” port on the second (middle) Mix Engine card.

7. Reconnect the ribbon cable to the port labeled “FOHA” on the first (innermost) Mix Engine card.

8. Locate the port labelled “P1 Mix Engine” on the Hub 48 card and the cable connected to it. Do one of the following depending on your configuration:
   - For a Mix Rack with the Clock Source umper cable, connect the cable to the ports labelled “Snake” on the first (innermost) and second Mix Engine card (see Figure 12 on page 6). Make sure to orient the cable in the ports as it was originally oriented. This cable should **not** be connected to the third Mix Engine card (adjacent to the Hub 48 card).
   - or –
   - For a Mix Rack with a dual-connector cable (see Figure 13 on page 6), connect this cable to the port labeled “Snake” on the first (innermost) Mix Engine card. If you installed the new Mix Engine card **behind** what was originally the first (innermost) Mix Engine card, connect the cable to the newly installed card. If you installed the new Mix Engine card **between** the second Mix Engine card and the Hub 48 card, reconnect this cable to the original card.

   **Make sure any ribbon cables you are reconnecting are securely attached by making sure the plastic latches on the port are locked. If the latches are not locked, firmly but cautiously press the connector further into the port until the latches lock.**

9. Reconnect all Stage IO card ribbon cables, making sure to re-attach the cables to the same cards they were originally connected to.
Completing and Confirming Installation

To complete and confirm installation:

1. Reconnect the power, the FOH Link cable, and any other cables to the Mix Rack.

2. Power on the system.

3. Go to the Options page and click the Devices tab to view your system hardware status. The newly installed Mix Engine card should be displayed in the Mix Rack graphic. All Stage I/O should also be displayed.

4. Reattach Mix Rack’s faceplate after confirming system components.

Figure 22. Option > Devices page showing 3 Mix Engine cards in Mix Rack

⚠️ If any Stage I/O is not present in the Options > Devices page hardware graphic, shut your system down and check that all cables to Stage I/O cards are properly connected.
Appendix A: Compliance Information

Environmental Compliance

Disposal of Waste Equipment by Users in the European Union

This symbol on the product or its packaging indicates that this product must not be disposed of with other waste. Instead, it is your responsibility to dispose of your waste equipment by handing it over to a designated collection point for the recycling of waste electrical and electronic equipment. The separate collection and recycling of your waste equipment at the time of disposal will help conserve natural resources and ensure that it is recycled in a manner that protects human health and the environment. For more information about where you can drop off your waste equipment for recycling, please contact your local city recycling office or the dealer from whom you purchased the product.

Proposition 65 Warning

⚠️ This product contains chemicals, including lead, known to the State of California to cause cancer and birth defects or other reproductive harm. Wash hands after handling.

Perchlorate Notice

This product may contain a lithium coin battery. The State of California requires the following disclosure statement: “Perchlorate Material – special handling may apply. See www.dtsc.ca.gov/hazardouswaste/perchlorate.”

Recycling Notice

ורים

EMC (Electromagnetic Compliance)

Avid declares that this product complies with the following standards regulating emissions and immunity:
• FCC Part 15 Class B
• EN 55103-1 E2, E3
• EN 55103-2 E2, E3
• AS/NZS CISPR 22 Class B
• CISPR 22 Class B

FCC Compliance for United States

Radio and Television Interference

Communication Statement

NOTE: This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential installation. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful interference to radio communications. However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause harmful interference to radio or television reception, which can be determined by turning the equipment off and on, the user is encouraged to try and correct the interference by one or more of the following measures:
• Reorient or locate the receiving antenna.
• Increase the separation between the equipment and receiver.
• Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
• Consult the dealer or an experienced radio/TV technician for help.
Any modifications to the unit, unless expressly approved by Avid, could void the user’s authority to operate the equipment.

Australian Compliance

N1709

Canadian Compliance

This Class B digital apparatus meets all requirements of the Canadian Interference-Causing Equipment Regulations.

Cet appareil numérique de la classe B respecte toutes les exigences du Règlement sur le matériel brouilleur du Canada.

CE Compliance

(EMC and Safety)

Avid is authorized to apply the CE (Conformité Européenne) mark on this compliant equipment thereby declaring conformity to EMC Directive 2004/108/EC and Low Voltage Directive 2006/95/EC.

Korean EMC Regulations

이 기기는 가정용(외급) 전자파저항등기기로서 주 로 가정에서 사용하는 것을 목적으로 하며, 모 든 지역에서 사용할 수 있습니다.